
 

 

 

Welcome to WindO/I-NV4! 

WindO/I-NV4 is IDEC's screen creation software for the HG4G/3G, HG2G-5F, HG2G-5T and 
HG1G operator interfaces (touch screen displays.) WindO/I-NV4 is used to create projects or 
programs that layout display screens for the O/Is. Using this window based program, any of 
IDEC's touch screens can display information from a PLC, process status, or can be used to 
input data with virtual switches or keypads to make changes to a process. 

WindO/I-NV4 is easy and intuitive. Many of the processes are self-explanatory and guide you 
from step-to-step as you configure the O/I. The help menus are simple, straightforward, and 
are a good resource for getting additional information. 
Creating colorful displays has never been easier. With Symbol Factory you have 5000 built in 
images for your disposal. You can also import almost any Bitmap or JPEG file into your project. 

 

WindO/I-NV4 highlights: 

Built-in Serial and Network Protocols 

Pass-thru function 

Download, upload & view OI via Ethernet 

Debug function 

Over 5000 built-in bitmap library Supports Windows Fonts Supports Multiple Languages 
Supports Scripting 

Intuitive Drag & Drop Functionality 

Flexible Screen Display for Efficient Editing 

Workspace – easy to manage projects & screens 
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There are the following notes when you use WindO/I-NV4, please following the instruction. 

Supported MICRO/I 

WindO/I-NV4 supports the HG4G/3G, HG2G-5F, HG2G-5T, HG1G. 

Text and Fonts 

1) In a character input, when there are number restrictions of characters, such as a 
"Registration Text" or a "Message Display", a carriage return is equivalent to two 
characters. 

2) The font, line and the resized Picture displayed on WindO/I-NV4 may differ from a display 
with the MICRO/I, please make sure in the MICRO/I. 

3) If DPI setting in Windows is greater than 100%, dialog box may not be displayed properly. 
In this case, set DIP setting 100%. 

Edit 

1) WindO/I-NV4 does not have the limitation of number of editing screens which can be 
opened at the same time. The limitation depends on the RAM in PC. 

2) There are the following notes when you use NV Metafile. 

- When Paint object is used in the NV Metafile, the image is sometimes changed after 
resizing Picture or part object which NV Metafile is used. 

3) In Tag Editor, blank cell cannot be copied & pasted. 

4) If “None”, “Fore 100%”, “Back 100%” or gradation pattern is not selected as Patterns in the 
property of drawing objects and part objects and “Place on the Top Layer” is checked, the 
pattern is started from the left top side of the objects. If “Place on the Top Layer” is not 
checked, the pattern is started from the left top side of the screen. 

Communication 

1) The screen monitor cannot monitor the value of the Host device set for write only. Use 
Custom Monitor or Batch Monitor if you want to monitor the device. 

2) Do not write 16bit data or bit data to the 32bit device in Emerson ROC Protocol. 

3) Do not send more than one command at the same time if Ethernet is selected as User 
Communication Interface. 

4) The following points should be taken into consideration when Automatically obtain the IP 
address is selected. 

- If it takes time to get an IP address and communication is failed, download the project 
again. 

- Whenever downloading the project data, the MICTO/I gets an IP address. Therefore an 
IP address may be changed. 

- While using Monitor function, download the project after stopping the Monitor function. 

Touch Panel 

Notes - WindO/I-NV4 



 

 

When more than one button is pressed at the same time, due to the detection characteristics 
of an analogue type touch panel, only the gravity center of the pressed area is sensed and the 
unit assumes that only one button is pressed. Thus, when more than one button is pressed 
simultaneously, the resulting operation is not guaranteed. 

Compatibility of WindO/I-NV2 

The project file which is created by WindO/I-NV2 can be opened by WindO/I-NV4. However, 
the project file should be satisfied the following conditions. 

- The project file is saved by WindO/I-NV2 Ver.4.80 or newer version 

- HG4G/3G(Multimedia), HG4G/3G, HG2G-5F, HG2G-S/2G-5S or 
HG2G-S/2G-5S(Ethernet) is selected as Product Series 

 

If the following conditions are satisfied and drawing objects or part objects are overlapped 
between overlay screens, the display order of those objects might be different from 
WindO/I-NV2. In this case, enable "Place on the Top Layer" check box in the property dialog 
box of those drawing objects or part objects. 

- HG4G/3G(Multimedia), HG4G/3F, HG2G-5F is selected as Product Series in the project 

- Overlay screen is used 

 
 
  



 

 

<Runtime System Software> 

The following functions have been introduced. 

 Security function is enhanced. 

- Security setting can be changed on MICRO/I. 

- In function to limit Display or Operation, two or more security groups can be set. 

- Administrator, Operator, and Reader can be set to two or more users as the security 
groups. 

- The privilege to upload or download project data can be set to security groups that you 
create. 

- The user name which is logging in to the MICRO/I can be stored to Device Address. 

 Password authentication with MICRO/I is improved to require entering user name. 

 In "Image Type" of Chart, "None" can be selected. 

 In Selector switch, the function to change the position of the knob with the values of device 
addresses was added. 

 When downloading a ZNV project file using Key Button or file manager in system mode, 
whether to clear Keep Device can be selected. 

 In File Transfer function, supports file copy between external memory devices. 

 In Character Input, function to write NULL terminating character (0x00) as the end of 
string when string of maximum digits is input is added. 

 In Character Input, function to write NULL (0x00) after the end of the string is added. 

 Text alignment of Numerical Input and Character Input is adjusted depending on the 
length of the displayed strings. 

 If using Modbus RTU Master driver, the slave number for the target can be changed while 
the MICRO/I is running. 

 Web server function is improved. 

- Improved display speed of Custom Web Page. 

- The display of remote monitoring screen and remote operation screen is updated 
automatically when MICRO/I is reconnected with network. 

Bugs Fixed 

The following problems have been fixed: 

 O/I Link Slave Communication does not work when Modbus RTU Slave, S7-200(PPI) or 
S7-MPI is used as communication driver. 

 Maintenance port does not work when Modbus RTU Slave and O/I Link Slave are used as 
communication driver at the same time. 

 If invalid project is downloaded to MICRO/I, MICRO/I might be reset. 

 

<Application Software> 
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The following functions have been introduced. 

 The properties for new features of the Runtime System Software are added. 

 Simulator function is supported. 

 Print function is supported. 

 Performance of opening project and saving project is improved. 

 Following usability improvements are made. 

- In "Tag Editor" opened from "..." button, default value of "Target" combo box and so on 
is improved. 

- Icons on Ribbon - "View" tab - "Workspace" group are rearranged. 

- Appearance on "Project Window" when errors are found before downloading project is 
improved. 

- Tabs on "Project Settings" dialog box are displayed in multi-line. 

- Default value of "Number of Stored Data for Data Log per Device Address" in "Data 
Storage Area Management" dialog box is changed to 1024. 

Bugs Fixed 

The following problems have been fixed: 

 In Message Display, when "Align Text Horizontal" is "Center-Left" or "Left-Right", and its 
message contains value of device address, display position of the message is invalid. 

 After "Download Standard Fonts and Optional Fonts" check box is checked and 
downloading is performed, keep device addresses are cleared regardless of state of "Clear 
Keep Devices" check box. 

 When the communication driver is " Logix Native Tag (Ethernet)",  result of reading and 
writing to bit numbers of DINT tags may be invalid. 

 WindO/I-NV4 does not run when configuration file for "IP Address Manager" is invalid. 

 After removing items from "Quick Access Toolbar", keyboard input may not be able to do 
on WindO/I-NV4. 

 When project is downloaded, files may not be downloaded to External Memory. 

 In "Data Log Settings" - "Individual Settings" dialog box - "Data" tab, Allen-Bradley format 
device addresses may not be set correctly. 

 When Bar Chart which satisfies the following conditions exists, Editing Window cannot be 
used. 

- In "Data" tab, gradation pattern is set. 

- Size of object is small.  

 After changing communication driver, correct used count may not be displayed on "Used" 
column of "Tag Editor". 

 In "Project Settings" dialog box - "Communication Driver" tab, if "External Devices" is 
selected, values of "Expansion Settings" in "Communication Driver Network" tab are 
cleared. 

 In "Text" of Drawings, when "Use Text Area" check box is unchecked, size of the text on 
Editing Screen or value of "W", "H" may be invalid. 

 Warning message does not be displayed even if project is downloaded with "Custom Web 
Page Files" check box is checked and External Memory is not inserted in MICRO/I. 

 In "Project Settings" dialog box - "Communication Driver" tab, the following invalid 
combinations of communication drivers can be configured. 



 

 

- Modbus TCP Server and DM LINK Ethernet(UDP) 

- Modbus RTU Slave and DM LINK Ethernet(UDP) 

- DM LINK(1:1) and DM LINK Ethernet(UDP) 

- DM LINK(1:N) and DM LINK Ethernet(UDP) 

 In Alarm List Display, dotted lines indicate display area may not be displayed. 

 Bar Chart and Pie Chart cannot be duplicated correctly if "Enable Increment Address 
Number" check box is checked. 

 In "Script Editor" dialog box, tag names may not be displayed correctly. 

 For some of dialog boxes, when the dialog box is opened, it may be displayed outside of 
PC’s display(s) and it causes to seem that WindO/I-NV4 is frozen. 

 Selection state of part objects may be invalid after executing "Undo" or "Redo". 

 When "Duplicate Screen" is opened from "Project Window", default selected item may not 
be correct. 

 

<Web Page Editor> 

Bugs Fixed 

The following problems have been fixed: 

 When you enter "transparent" in the FillStyle dialog box, nothing may be shown on the 
dialog box. 

 An error message is displayed when web page containing a multi-state lamp is shown and 
an image associated to the multi-state lamp does not exist. 

 When an animation GIF image containing transparent color is specified, the animation is 
not displayed properly. 

 Font size may not be adjusted correctly when both "Adjust to the browser width when 
runtime" and "Adjust to the browser height when runtime" are enabled for the layer size 
settings. 

 When a tab component is placed inside another tab component, the font size of the tab 
component placed inside may not be adjusted. 

 When properties of a component placed inside a tab component are changed, Redo 
operation does not function. 

 When grouped components are grouped with additional components and placed inside a 
tab component, the group ID of those components are changed. 

 When setFillStyle() is called in JavaScript of Label component, background color of the 
Label component may not be changed. 

 When a trend component and a Text Input component are linked, labels of Y-axis of the 
trend component may not be displayed properly. 

 When the data for Line1 of a Trend component is not updated, Snapshots are not saved 
properly. 

 If a font containing space character such as ‘MS Gothic’ is specified in the Font property, 
the specified font type may not be selected when the Font property is opened again. 

 When positons of Label components contain digits after the decimal point, unnecessary 
lines may be displayed on the extended line of the label frame line. 

 



 

 

<Application Software> 

Bugs Fixed 

The following problems have been fixed: 

 When WindO/I-NV4 is launched with a user account which does not have administrator 
privileges and project file is opened, if internal error is occurred with tag editor, the 
following problems might be occurred. 

- WindO/I-NV4 crashes. 

- An error message is displayed and the project file cannot be opened. 

- The screens which saved in the project file cannot be displayed. 

 If "External Device Name" is changed from default value on "Communication Driver 
Network" tab of "Project Settings" dialog box, the following problems are occurred. 

- External device address is configured as "Top Device Address" of Data Log function, 
"Data Log Settings" dialog box cannot be closed by clicking "OK" button. 

- If old project file which configured above setting is converted by WindO/I-NV4 Version 
1.7.0, "Top Device Address" setting is deleted on "Data" tab of "Individual Settings" 
dialog box of Data Log function. 
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<Runtime System Software> 

The following functions have been introduced. 

 Data Log function is extended. 

- "While satisfying the condition of writing to data storage area" is added to sampling 
method. 

- Any device address can be specified as output data. 

- "String(S)" (string) is added to data type of output data. 

- Output items for header of CSV file can be selected. 

 The number of external device address which can be used on one screen is expanded to 
512 points. 

 Display area of text for parts placed on the top layer is expanded. 

 In E-mail function, SMTPs is supported. 

 In E-mail function and FTP client function, Host name can be specified as server. 

 In "Ethernet" settings of MICRO/I, DNS server can be specified. 

 The maximum number of Transmission commands and Receive commands per Protocol in 
User Communication is expanded to 255. 

 For "Monitor Sampling Count" in "Data Log Settings" and "Monitor Number of Stored Data" 
in "Operation Log Settings", the behaviors are reconsidered. 

 Validation of the overlapped port number for maintenance communication is enhanced. 

 The following Communication Driver is supported. 

- GE Fanuc Automation SNP 

 The maximum number of multiple Read/Write setting is supported with the following 
Communication Drivers. 

- Modbus RTU Master 

- Modbus RTU ASCII 

- Modbus TCP Client 

 The displayed message when a communication error occurred is improved. 

Bugs Fixed 

The following problems have been fixed: 

 If the external device address is inserted in the body text of e-mail, wrong value may be 
inserted. 

 If the maximum number of external device address is set on the base screen, MICRO/I 
cannot communicate with the external devices properly.  

 When the 1:1 communication driver and the 1:N communication driver are used at the 
same time, the value of external device addresses might be not updated. 

 In Web server function, if the MICRO/I Installation direction is set to Horizontal (Rotate 
180°), when the sub screen is moved by remote operation, the sub screen moves to a 
different position from the set coordinates. 
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<Application Software> 

The following functions have been introduced. 

 The properties for new feature of the Runtime System Software are added. And 
the captions of the properties for other features are reconsidered. 

Bugs Fixed 

The following problems have been fixed: 

 If "Internal Memory" is selected as "Access to" setting with Recipe function, Recipe 
function may be not running properly. 

 If "Internal Memory" is selected as "Access to" setting with Recipe function and a same 
string is configured as "File Name" setting of multiple channels, the following problems are 
occurred when project file is opened after saving project. 

- If "Enable" is selected with each channel, all values of "Data List" becomes same value. 

- If "Enable" and "Disable" is configured with each channel, all values of "Data List" 
becomes 0. 

 If project file of WindO/I-NV2 of which pictures are registered in Picture Manager is opened 
with WindO/I-NV4, project file might not be able to be opened. 

 If WindO/I-NV4 is relaunched after registering group on ribbon menu to Quick Access 
Toolbar, a part of GUI for group which registered in Quick Access Toolbar is not displayed. 

 If tag name of device address used in "Script Editor" dialog box contains a double-byte 
character and single-byte character and last character is hexadecimal, error check of 
"Script Editor" dialog box is not running. 

 If project is saved after strings is configured on "Multi-Language String Editor" dialog box 
of Web Page Editor function, settings in "Multi-Language String Editor" is deleted when 
project file is opened. 

 In icon of base/popup screen on "Project" window, the screen icon with the incorrect 
setting may be blue or the screen icon with the correct setting may be displayed in red. 

 If the version of the project downloaded to MICRO/I is newer than the version of 
WindO/I-NV4 used for uploading the project, WindO/I-NV4 crashes when project is 
uploaded. 

 If "Screens" group of "View" tab in ribbon menu is registered to Quick Access Tool Bar and 
the project is opened, WindO/I-NV4 crashes. 

 If "Screens" group of "View" tab in ribbon menu is registered to Quick Access Tool Bar, the 
"ON/OFF" icon corresponding to the state of Parts is not displayed. 

 When the following textboxes are added to Quick Access Tool Bar and characters other 
than numbers are entered in it, WindO/I-NV4 crashes. 

- "View" - "Screen" – "State" text box 

- "Online" - "Monitors" - "Screen Number" text box 

 In Preview function, if Alarm List Display of which message of Windows font is configured is 
displayed, the unnecessary dotted rectangle is displayed. 

 In "E-mail Settings" dialog box, if project is saved after "(tab)" is entered in the [body] text 
box, the "(tab)" is changed to "?(Question)" when the project file is opened. 

 When "Expression of Device Address Format" is "Allen-Bradley" and "Bit Number Symbol" 
is "Dash", the following device address cannot be configured. 



 

 

- Allen-Bradley - MicroLogix/SLC 500 (Full Duplex) 

* WI (Input (Word)) 

* WO (Output (Word)) 

- Allen-Bradley - SLC 500 (Half Duplex) 

* WI (Input (Word)) 

* WO (Output (Word)) 

- Allen-Bradley - Logix Controllers (Ethernet) 

* SWI (SLC/MicroLogix Input (Word)) 

* SWO (SLC/MicroLogix Output (Word)) 

 When "Expression of Device Address Format" is "Allen-Bradley", the following device 
address cannot be configured. 

- Allen-Bradley - PLC-5(Half Duplex) 

* WI (Input(Word)) 

* WO (Output(Word)) 

 When "Expression of Device Address Format" is "Allen-Bradley", even if "Expression of 
Device Address Format" is changed from "Dash" to "dot", the delimiter of device address is 
not changed. 

 After a part on screen is copied and pasted when [Increment Address] is enabled, if 
[Trigger Condition] of the copied part is edited with Object List, the configured device 
address of [Trigger Condition] of source for the copied part is changed. 

 If a part on screen is copied and pasted when [Address Adjustment] is enabled, the 
configured device address in [Trigger Condition] of source for the copied part is changed. 

 In property dialog box of Volume, if a specific number of characters are set in "Part Name" 
text box on "General" tab and the project is downloaded to MICRO/I, MICRO/I keeps 
resetting. 

 If there are many parts of which Windows font is configured in project, the base screen or 
sub screen might not displayed when the project is opened. 

 In "Command Settings" dialog box for user communication setting, an error message is 
displayed even though value of "Transmission Wait" setting is less than value of "Period" 
setting for "Fixed Period". 

 



 

 

<Runtime System Software> 

The following functions have been introduced. 

 Additional supported Communication Drivers. 

- Hitachi Industrial Equipment Systems EH 

- JTEKT (Toyoda) TOYOPUC(Ethernet) 

 The usable device address ranges of the following IDEC drivers are extended. 

- IDEC OpenNet,MICROSmart,SmartAXIS Pro/Lite(RS232C/485) 

- IDEC OpenNet,MICROSmart,SmartAXIS Pro/Lite(Ethernet) 

 PLC Program Transfer Function supports IDEC MICROSmart FC6A Plus. 

 Pass-Through Function supports IDEC MICROSmart FC6A Plus. 

 Enhance the verification of the overlapped port number for maintenance communication. 

Bugs Fixed 

The following problems have been fixed: 

 The number of lines which is shown on Alarm Log Display may be different between 
WindO/I-NV4 and MICRO/I. 

 In Device Monitor of MICRO/I, device address is not automatically incremented if the 
External Device ID is not 0. 

 In Message Switching Display, when display color is changed while the message is scrolling, 
the message does not scroll properly. 

 In Pie Chart, if it does not contain any channel data, MICRO/I might be reset after the 
project is downloaded. 

 MICRO/I might not be able to communicate with USB barcode reader even if it is 
connected with the MICRO/I. 

 If Keyence KV (Ethernet) is selected as Communication Driver, and MICRO/I write value to 
the following devices, wrong value is written to the PLC. 

- Timer (Current Value) 

- Timer (Preset Value) 

- Counter (Current Value) 

- Counter (Preset Value) 

 

<Application Software> 

The following functions have been introduced. 

 Symbol Factory included in WindO/I-NV4 is updated. 

Bugs Fixed 

The following problems have been fixed: 
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 If the file name of the project created by WindO/I-NV4 Ver.1.1.0 is changed, the project 
cannot be opened by WindO/I-NV4 Ver.1.3.0 or newer version. 

 In "Project Settings" dialog box, once confirmation message or error message is displayed 
by pressing "OK" button, even if "Cancel" button is pressed in "Project Settings" dialog box, 
the configuration of the dialog box may not be changed back. 

 If tag name contains "ﾄ" or " Ä", it cannot be used in "Trigger Condition". 

 In Tag Editor, if the same tag name is assigned to device address which "Target" is different, 
the following problems happen. 

- If the same tag names are used in the setting of Part Object or Configuration, the 
different device addresses are changed to the same device address when the project 
file is reopened. 

- Even if the tag name is deleted, the tag name is displayed after reopening the project 
file. 

 In Word Button, if both of the following conditions are satisfied, the decimal part in "Value" 
text box is removed after reopening the project file. 

- "Add", "Sub", "Multi", "Div" or "Mod" is selected as "Action Mode" 

- "Float32(F)" is selected as "Data Type" 

 In "E-mail Settings" dialog box, if some specific Japanese character is used in "Body" text 
box, the text is corrupted after reopening the dialog box. 

 If both of the following conditions are satisfied, the following problems happen in the text 
box for device address. 

<Condition> 

- In "Setting" of "Communication Driver Network" tab in "Project Settings" dialog box, 
more than one "External Device Communication" are configured. 

- "External Device Name" is changed from the default. 

 

<Problem> 

- When opening an old version of a project with a newer version of WindO/I-NV4, device 
addresses of External Device in "Trigger Condition", "Input with Arithmetic Operation" 
and "Display with Arithmetic Operation" are deleted. 

- In "E-mail Settings" dialog box or "E-mail Address Book" dialog box, the dialog box 
cannot be closed by error message even though proper device address of External 
device is assigned. 

- When "Undo" or "Redo" is used, the device address which is assigned before the 
operation is deleted. 



 

 

<Runtime System Software> 

The following functions have been introduced. 

 Change the message displayed when a communication error occurred. 

 The function which monitors the connection status between MICRO/I and the external 
devices is supported. 

 The port number for maintenance communication can be set. 

 "Storage Method of 32-bit Numerical Data" can be set for each external devices. 

 In the following parts, the function that starting scrolling after displaying message is 
supported. 

- Message Display 

- Message Switching Display 

- Alarm List Display 

Bugs Fixed 

The following problems have been fixed: 

 If there are some e-mail is set "Disable", an e-mail whose condition is not satisfied may be 
sent. 

 If scrolling strings containing newline characters may cause wrong display. 

 In FTP client function, Incorrect error information may be stored when FTP transmission 
fails. 

 In FTP client function, if the upload target file name is shorter than the upload destination 
folder name, the uploaded file name will is changed. 

 FTP client communication is failure if MICRO/I's FTP Server function is enabled with using 
"Specify Target". 

 

<Application Software> 

The following functions have been introduced. 

 The properties for new features of the Runtime System Software are added. 

 "Set Conversion Option" is available when changing product series from / to the HG1G. 

Bugs Fixed 

The following problems have been fixed: 

 If an external character of Japanese is used in "Text" drawing object, the screen is not 
displayed properly. In addition, the screen cannot be saved.  

 If a project is opened from "Project Recovery" dialog box, the following issues happen. 

- If the project is created by older software versions, the project may not be converted to 
the current software version. 
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- Even if the project is created by newer software versions, the project can be opened. 

 In "Text" drawing object, if the following conditions are satisfied, the text area is not 
displayed properly. 

- "Vertical Writing" checkbox is ON 

- "Use Text Area" checkbox is OFF 

- "Windows" is selected as "Font" 

 WindO/I-NV2 project may not be opened. 

 In "Security" dialog box, an error message is not displayed even if "User Name" is blank. 

 In "Project Settings" dialog box, an error message is not displayed even if the number of 
"Port Number" is overlapped. 

 If "OK" button is pressed in "Communication Driver Extension Settings" dialog box, the 
current tab in "Project Settings" dialog may be changed. 

 When WindO/I-NV2 project is opened in WindO/I-NV4, part objects and drawing objects 
may not be placed on Top Layer. 

 When the project file is reopened, the flange size of Selector Switch is decreased. 

 In "Change Product Series" dialog box, even if "Zooming Conversion" is selected as "Set 
Conversion Option", "Round Radius" in the property of "Rectangle" is not converted. 

 



 

 

<Runtime System Software> 

Bugs Fixed 

The following problems have been fixed: 

 When "Picture" or "None" is selected as "Image Type" of following part objects, if Text 
Color and Plate Color are changed by using "Change Display Colors" or "Flash" function in 
Format tab, the background color of the displayed characters becomes Plate Color. 

-  Numerical Input 

-  Numerical Display 

-  Character Input 

-  Message Display 

-  Message Switching Display 

 

<Application Software> 

Bugs Fixed 

The following problems have been fixed: 

 Proper items are not displayed in "Project" window. 

 In Meter, when "Data Type" is changed in "General" tab, and then the "Value" in "Range" 
tab is changed to the same value which was set before changing "Data Type", the screen 
which contains the Meter is not displayed properly. 

 If "New User Account" or "Change User Account" dialog box is opened from "Security" 
dialog box, and then security groups are added, the security groups may not be displayed 
in "Web Page" tab in "Security Settings" dialog box. 
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<Runtime System Software> 

The following functions have been introduced. 

 File Transfer function is supported. 

 Web Server function is extended. 

- Web page editor function is supported. 

- Default Showing Page setting is supported. 

- Security Setting for Custom Web Page is added.  

 E-mail function is extended. 

- Attaching Files is supported. 

- The function to insert the value of device address is supported. 

 PLC Program Transfer Function supports IDEC MICROSmart FC6A series. 

 Pass-Through Function supports IDEC MICROSmart FC6A series. 

 The MICRO/I supports IDEC MICROSmart FC6A expansion I/O modules.  This is 
applicable to HG4G/3G and HG2G-5F. 

- Input Modules 

- Output Modules 

- Combination I/O Modules 

 LSM (HMI Special Internal Relay) and LSD (HMI Special Data Register) support the 
functions below. 

- Changing the port number of external device. 

- Showing the version of MICRO/I system software. 

Bugs Fixed 

The following problems have been fixed: 

 When "16x16" is selected as "Size" in Format tab of Numerical Input, only half of the 
numeric string of the Numerical Input is displayed. 

 When "None" is selected as "Image type" of Message Switching Display, if the plate color of 
Message Switching Display is changed, the background color becomes black. 

 When uploading and downloading the files at the external device with maintenance 
communication via USB, the communication timeout may occur. 

 In Files Copy function, the root folder is selected as the "Location" of "Destination", 
MICRO/I makes a folder with no name. 

 When inserting and pulling the HID class USB device with the USB interface (USB 2) 
repeatedly, the communication to the device may be failure.  This is applicable to 
HG2G-5T and HG1G. 

 The cursor of the Alarm List Display may be drawn incorrect. 

 The cursor of the Alarm Log Display automatically moves to the top line. 

 When drawing characters whose length is exceeding the size of the Alarm List Display, the 
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background color of the area which is out of the Alarm List Display is drawn with the plate 
color of it. 

 Switching to the screen which has the parts with using the gradation is slow. 

 The FTP Server function returns wrong create time of file and folder.  This is applicable to 
HG2G-5T and HG1G. 

 In the FTP Server function, an access error may occur when moving from the folder which 
is specified at login to the lower folder.  

 In the FTP Server function, when a file name is changed, the file moves to the root folder.  
This is applicable to HG2G-5T and HG1G. 

 

<Application Software> 

The following functions have been introduced. 

 The properties for new features of the Runtime System Software are added. 

 Following usability improvements are made. 

- When "Picture Name Settings" dialog box is opened after selecting a picture from 
"Symbol Factory", default picture name is now set. 

- The default value of "Storage Method" in "Alarm Log Settings" dialog box is changed to 
"Rotate". 

- The default value of "Action Mode" in "Properties of Bit Button" dialog box is changed to 
"Momentary". 

- The default value of "Basic / Advanced" in properties dialog box of part objects is 
changed to "Advanced". 

- The default value of "Data Bits" in "Project Settings" - "Communication Interface" tab is 
changed to "8" when "User Communication" is selected as "Function". 

- The displayed string in "Ethernet" - "Function" of "Project Settings" - "Communication 
Interface" tab is changed to "hyphen", instead of "Not Use". 

- The default value of "IP Address" displayed when "Ethernet" is selected in "Project 
Settings" - "Communication Interface" tab is changed to "192.168.1.6". 

- The caption of "Auto-change IME" check box in "WindO/I-NV4 Options" dialog box is 
changed to "Enable Input Method Editor (IME) when entering Device Address". 

- "European Large Font" check box in "Project Settings" - "Font Settings" tab is now 
selected as default. 

 The device address of the following part objects now cannot be modified from "Object 
List". 

- Message Display 

- Bart Chart 

- Pie Chart 

Bugs Fixed 

The following problems have been fixed: 

 If the following operation is performed when the following conditions are satisfied, blank 
item is displayed as "User Name" in "Enter Password" dialog box. 

<Condition> 



 

 

- The password is not configured to the user who is assigned to Administrator group. 

- The password is configured to the user who is assigned to Operator group or Reader 
group. 

<Operation> 

- Upload the data from the External Memory. 

- Download the data to the External Memory while the MICRO/I is running. 

 If the password is deleted when "Use Security function" check box is OFF, the deleted 
password is displayed as "Confirm Password" in "Change User Account" dialog box. 

 In "Recipe Setting", if numerical value is copied and pasted to "Data" cell on "Data" tab in 
"Individual Settings" dialog box, it is pasted twice. 

 If Windows font is selected and "tilde" is used as character, it is displayed "Question mark" 
in Editing Window and the MICRO/I. 

 In "E-mail Address Book" dialog box, the E-mail Address which is hidden by "Find" function 
is treated as a selected item. 

 When a Text ID is selected from "Text Manager", if "Text Manager" is closed while entering 
a character, the Text ID is not selected. 

 If "Undo" operation is used for Bar Chart or Pie Chart, an unnecessary error message is 
displayed when the project is downloaded. 

 In the property dialog box of Picture Display, if the following operations are performed, the 
configuration is not recovered. In addition, the registered picture cannot be deleted from 
Picture Manager. 

- Register a picture in "View" tab and close the dialog box by clicking "OK" button, and 
then use "Undo" or "Redo" 

- Change "Switching Method" in "General" Tab from "Value" to "Bit Number", and then 
use "Undo" or "Redo" 

 If communication driver is changed to "Not Use" when "Monitoring communication error 
information for each station, individually" is enabled, and then the project is downloaded, 
MICRO/I keeps resetting. 

 In "E-mail Settings" dialog box, after configuring E-mail setting for other than No.1, if a 
device address which is used in "Trigger Condition" is replaced to an invalid device address, 
the following problems happen. 

- Error message for the invalid device address is not displayed when "OK" button is 
pressed in "E-mail Settings" dialog box 

- The device address which is configured before executing replace function is displayed 
in "E-mail Settings" dialog box 

 When "Function" is changed in "Communication Interface" tab in "Project Settings" dialog, 
the settings in "O/I Link" tab is change back to the default. 

 After arranging Selector Switch or Potentiometer on Editing Window, if "Copy and Paste" or 
"Duplicate" is used for them, and download the project, the buttons for these Selector 
Switch and Potentiometer are not displayed on the MICRO/I. 

 When WindO/I-NV4 is restarted, the setting value of "Increment Address" is change back 
to 0. 

 When "Parts on the Top Layer" check box is OFF in "Object List", even if the corresponded 
drawing objects and part objects are not displayed, they can be selected by multiple select 
operations using Shift Key or Ctrl + A key in "Object List". 

 If "Security" dialog box is closed by "Cancel" button, and it is opened again, all the settings 



 

 

are cleared. In addition, if this dialog box is closed by "OK" button, invalid settings are 
stored into the project. 

 If "Internal Memory" is selected as "Access to", and the project is downloaded without 
saving, Recipe data is not downloaded. 

 Mitsubishi Electric MELSEC-FX5U(LINK) driver and Mitsubishi Electric 
MELSEC-FX5U(Ethernet) cannot be used.(This defect only happens in English Edition.) 

 Even if device addresses which are used in the formula of Trigger Condition is replaced by 
Replace Function, it does not reflect to the behavior of the MICRO/I. 

 In "Data Settings" dialog box of User Communication function, the text box which is 
displayed when the following item is selected does not support multi line text. In addition, 
a line feed cannot be entered by "Enter" key. 

- Constant (Character) 

- Constant (Hexadecimal) 

- Registering Constant (Character) 

- Registering Constant (Hexadecimal) 

 



 

 

<Runtime System Software> 

The following functions have been introduced. 

 Additional supported Communication Drivers. 

- MITSUBISHI MELSEC-FX5U(LINK) 

- MITSUBISHI MELSEC-FX5U(Ethernet) 

 The usable device address number ranges of the following IDEC drivers are extended. 

- OpenNet,MICROSmart,SmartAXIS Pro/Lite(RS232C/485) 

- OpenNet,MICROSmart,SmartAXIS Pro/Lite(Ethernet) 

 

<Application Software> 

The following functions have been introduced. 

 Checking for updates function of Automation Organizer has supported Microsoft .NET 
Framework 4. Install of Microsoft .NET Framework 2.0 to 3.5 is not needed by this support. 

Bugs Fixed 

The following problems have been fixed: 

 The character of Thai and Arabic is used as Windows font, it is not displayed properly. 

 In Numerical Display, if " (Space)" is selected as "Symbol to show when Error occurs", it is 
changed to "?(Question)" after reopening the project. 

 If the text which is registered in "Text Manager" contains a double quote, export function 
does not work properly. 

 In "User Communication" tab on "Project Setting" dialog box, if the following conditions are 
satisfied, an error message is displayed even if the all settings are correct. This happens 
when a data except "Constant" is configured and OK button is pressed in the "Data 
Settings" dialog box.  

 

In "Command Settings" dialog box of "User Communication" tab, there is at least one Data 
which satisfies all the following conditions. 

- "Command Type" is "RXD" 

- "Type" of Data is "Device Address" 

- "Variable" is enabled 

 In "User Communication" tab on "Project Setting" dialog box, even if the following 
conditions are satisfied, an error message is not displayed when OK button is pressed in 
the "Command Settings" dialog box.  

 

- In "Command Settings" dialog box of "User Communication" tab, there is at least one 
Data which satisfies all the following conditions. 
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*  "Command Type" is "RXD" 

*  "Type" is "Device Address" 

*  "Variable" is enabled 

- "Type" of the Data next to the above Data is not "Constant"  

 If the project contains a "Word Button" with "Comment" and it is created by using 
WindO/I-NV4 Ver.1.0.0 - 1.1.0, "Failed" may be displayed when the project is opened by 
WindO/I-NV4 Ver.1.2.2 or later. 

Even if "Failed" is not displayed, and "Success" is displayed, base/popup screen may not be 
displayed properly. 

 When a base screen or popup screen is copied and pasted on "Project" window, the new 
screen is not displayed if the screen contains drawing objects. 

In addition, when the new screen is opened after doing the above operation, the drawing 
objects which are placed in the copied screen are not displayed properly. 

 The following devices are not displayed when "MEWNET"("松下电器") is selected as 

Communication Driver. 

(This defect only happens in Chinese Edition.) 

 

- 定时器，计数器(经过值) 

- 定时器，计数器(预置值) 

 When the project which is created by using WindO/I-NV2 Ver.4.80 is opened by 
WindO/I-NV4 and saved, the project cannot be opened. 

 When "Text" drawing object is registered in "Picture Manager" and "Use Text Area" is 
enabled in the object, the project cannot be opened. 

 In "Text" drawing object, if "Use Text Area" is disabled and the object is registered to 
"Picture Manager" as NV Metafile, the object is always displayed at the top left corner of 
Editing window when the object is assigned to the "Picture" object or Part objects such as 
Bit Button. 

 If an E-mail address is deleted when more than one E-mail address is registered in "E-mail 
Address Book", and then the project file is saved, E-mail addresses in "E-mail Settings" 
dialog are changed to other E-mail address or deleted. 

 



 

 

<Runtime System Software> 

The following functions have been introduced. 

 E-mail function is supported. 

 Improve the USB autorun function screen.  This is applicable to HG2G-5T and HG1G. 

 Improve writing recipe values. 

 Improve the display processing when the MICRO/I installation direction is "Vertical 
(Counter Clockwise)", "Vertical (Clockwise)" or "Horizontal (Flip)". 

 Improve the touch sound when the data for Keep Relays and Keep Register configured in 
the Data Storage Area are transferred to the flash memory.  This is applicable to HG2G-5T 
and HG1G. 

Bugs Fixed 

The following problems have been fixed: 

 The items of the Alarm Log Display may not be shown. 

 When the calendar is configured, its setting is not immediately reflected. 

 The MICRO/I might be reset during Offline Mode. 

 The Symbol to show when Error occurs of the Numeric Input is not work correctly.  This is 
applicable to HG4G/3G and HG2G-5F. 

 The MICRO/I might be reset when placing the NV metafile which includes "Fill" on the top 
layer. 

 

<Application Software> 

The following functions have been introduced. 

 The properties for new feature of the Runtime System Software are added. 

 For Alarm List Display on Editing Window of WindO/I-NV4, drawing of dotted rectangle 
which indicates the text area is improved. 

Bugs Fixed 

The following problems have been fixed: 

 When WindO/I-NV2 project is opened and the language of WindO/I-NV2 that creates the 
project and the language of WindO/I-NV4 that opens the project are different, a part of 
device address is removed from following textbox. 

- Numerical Input - "Options" tab - "Input with Arithmetic Operation" 

- Numerical Input - "Options" tab - "Display with Arithmetic Operation" 

- Numerical Display - "Options" tab - "Display with Arithmetic Operation" 

- "Script Editor" - "Script" 

- Part objects - "Trigger Condition" tab - "Condition" 
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 When a project file is opened and if the languages of WindO/I-NV4 that creates and opens 
the project are different, for Numerical Input and Numerical Display, conversion of device 
symbols in "Input with Arithmetic Operation" and "Display with Arithmetic Operation" may 
fail. 

 Tooltips of buttons on Tag Editor is displayed in English when Japanese or Chinese edition 
of WindO/I-NV4 is launched with closing Tag Editor, and then Tag Editor is opened. 

 When project file for recovery is opened, string resources on Tag Editor are not displayed 
correctly. 

 "x" button is displayed on the top right corner of the warning message which is shown 
when "Communication Driver" is not connected to MICRO/I. 

 For the following Communication Drivers, "IP Address" and "Port Number" on 
"Communication Driver Network"tab in "Project Settings"dialog box are editable. 

- Modbus TCP Server 

- DM LINK Ethernet(UDP) 

 Shortcuts of "Object List" are not running when "Object List" is undocked. 

 When "Message" of Message Display is modified from "Object List", error check is not 
done. 

 When groups of drawing objects are nested, property dialog box of the drawing object may 
not be opened from "Object List". 

 When project is not downloaded to MICRO/I or project is not opened in WindO/I-NV4, 
incorrect value is displayed in the "Target Project Information" or "Opened project 
Information" in "Target Information" dialog box. 

 When "Picture Manager" or "Script Manager" is opened from property dialog box and two 
or more pictures or scripts are selected, "Select" button is not masked. 

 "Undo" function for "Auto Resize" function is not running properly. 

 In "Picture Manager", picture name which length is 121 characters or more can be set.  

 In Recipe Settings, if "Access To" is "Internal Memory", "Data List" is not restored after 
uploading project. 

 Project file may not be opened properly if the file extension contains capital letters. 

 When project file is saved, if project file name input by user contains file extension and the 
file extension contains capital letter, extra file extension is appended. 

 After "Rotate Right 90°", "Rotate Left 90°", "Flip Vertical", or "Flip Horizontal" is clicked, 
"X-coordinate", "Y-coordinate", "Width", and "Height" on [Format] tab of Ribbon are not 
updated. 

 If Polyline or Polygon is arranged, "X-coordinate" or "Y-coordinate" on [Format] tab of 
Ribbon is modified, and then "Width" or "Height" is modified, incorrect image is displayed. 

 Accelerator key of "< Basic" button and "Advanced >" button on property dialog box of 
part objects is not running properly. 

 In property dialog box of Word Button, unnecessary control is displayed when "Data Type" 
is other than "Float32(F)" and "Action Mode" is Arithmetic operation or Logical operation. 

 For Selector Switch, if "Font" of each channel is different, "Text" of Channel 2 and 3 are 
drawn on Screen Window with "Font" of Channel 1. 

 WindO/I-NV4 may freeze when "Picture Manager" is opened from property dialog box of 
Picture Display, and a picture that is used in the Picture Display is overwritten by other 
picture which file name is same as the picture. 

 In property dialog box of Message Switching Display, strings updated on "Text Manager" 



 

 

dialog box may not be applied properly. 

 In Alarm List Display, correct text may not be displayed on Editing Window. 

 The number of lines which is shown on Message Display may be difference between 
WindO/I-NV4 and MICRO/I.  

 In property dialog box of Message Switching Display, "Change" column of "Settings" list 
becomes blank when "Use Text Manager" is enabled. 

 In property dialog box of Alarm Log Display, if "Height(dots)" is 161 or more, it is not 
restored correctly after saving and opening project. 

 In the property dialog of Message Switching Display, the cursor on the character string in 
"Message" column of "Message" tab cannot be moved. 

 



 

 

<Application Software> 

Bugs Fixed 

The following problems have been fixed: 

 In text boxes of the following dialog boxes, line feed cannot be inserted even if the Enter 
key is pressed. 

- Selector Switch - "Notch Settings" dialog box 

- Multi-State Lamp - "State Settings" dialog box 

 In Multi-Button, when "Word Write" is selected as the first function in "Function List" and 
"Action Mode" is either Arithmetic, Modulo, or Bit Operation, even if "Device Address" is 
selected as "Source2" on "General" tab, the setting is changed to "Value" after reopening 
the project. 

 In Numerical Display, when other than "BIN16(W)" is selected as "Data Type", and an 
expression including value which is not an integer number from 0 to 65535 is entered in 
"Display with Arithmetic Operation" in "Options" tab, error message appears when the 
project is downloaded and the project cannot be downloaded. 

 In Numerical Display, it has the following problems. 

- When “*(asterisk)” is selected as “Symbol to show when Error occurs”, it is changed to 
“!(exclamation mark)” after closing with “OK” button and then reopening the property 
dialog box. 

- When “!(exclamation mark)” is selected as “Symbol to show when Error occurs”, it is 
changed to “+(plus)” after closing with “OK” button and then reopening the property 
dialog box. 

- When “+(plus)” is selected as “Symbol to show when Error occurs”, the property dialog 
box cannot be opened again after closing with “OK” button. 

 When a project which stores pictures in External Memory is uploaded and the External 
Memory is ejected at that time, following problems occur in the uploaded project. 

- When project file for External Memory (ZNV file) is created, error message appears and 
creating ZNV file fails. 

- When the setting of the picture which is stored to External Memory is changed to store 
to Internal Memory, and the project is downloaded, the drawing of picture on MICRO/I 
is incorrect. 

- When the picture is used in Picture Display, the picture name is changed. 

 In the property dialog box of Part Objects and Settings, when the device address which 
satisfies the following condition is assigned to the Text Box, even if [...] button is pressed, 
Tag Editor does not appear. 

- “Device Type” is a device type which has more than one range of “Device Ranges” 

- “Address Number” is greater than the range of the first item of “Device Range” 
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<Runtime System Software> 

The following functions have been introduced. 

 The judgment of device range error is improved.  This is applicable to HG4G/3G and 
HG2G-5F and HG1G. 

 The size of Password Screen is enlarged.  This is applicable HG1G. 

Bugs Fixed 

The following problems have been fixed: 

 In Picture Display, if used "Dynamic Position" or "Dynamic Size", the picture before moving 
or scaling remains. 

 

<Application Software> 

Bugs Fixed 

The following problems have been fixed: 

 MICRO/I may not work properly if comment is set in Word Button or Multi-Button (the first 
function is Word Write or Script) and the button is pressed on MICRO/I after the project is 
downloaded. 

 If Data Displays or Charts is arranged and project is downloaded, the plate part of the 
object may not be drawn properly on MICRO/I. 

 In "Custom Monitor", "Batch Monitor", and "Screen Monitor", if used device address is 
Hexadecimal, MICRO/I access to incorrect device address. 

 In "Communication Driver Network" tab on "Project Settings" dialog box, if the following 
communication drivers are assigned to more than one External Device ID and "OK" button 
is clicked, an error message appears, but the "Project Settings" dialog box closes. 

- DM LINK(1:1) 

- DM LINK(1:N) 

- DM LINK Ethernet(UDP) 

- Modbus RTU Slave 

- Modbus TCP Server 

 The settings are not change back to the default when the property dialog box of the 
following part objects is changed to Basic mode from Advanced mode by using 
"Basic/Advance" button. 

- Numerical Input 

- Line Chart 

- Alarm List Display 

- Alarm Log Display 
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- Video Display 

 When WindO/I-NV2 project is opened in WindO/I-NV4, even if the project name is less 
than or equal to 50 bytes, an error message is displayed and the project cannot be opened. 

 If Allen-Bradley Logix Native Tag is selected as Communication Driver, the tags which are 
assigned to part objects or settings may be deleted. 

 When the base screens and popup screens which are modified are closed in WindO/I-NV4 
window, the confirmation message for saving the project may not be displayed. 

 When "AutoRecover file" function or "Backup" function is enabled, the modification in base 
screens and popup screens may not be applied to the MICRO/I after downloading the 
project. 

 If WindO/I-NV2 project is opened by WindO/I-NV4 Ver.1.0.0 to Ver.1.0.4, and then the 
project is opened by WindO/I-NV4 Ver.1.2.0, "Failed" may be displayed at "Status" column 
in "Convert the project data" dialog box. 

 If "Channel Number" is changed on "General" tab in "Individual Settings" dialog which is 
opened from "Data Log Settings" dialog box, the saved project may not be opened. 

 After a project is downloaded with "Modified Data Only" option in "Download" dialog box, if 
the project is uploaded from MICRO/I, "Number of Text Group" in "Text Manager" dialog 
box may be changed to incorrect value. 

 "Sort" on "General" tab in the property of Alarm List Display cannot be changed from 
"Ascending". 

 When WindO/I-NV2 project is opened in WindO/I-NV4, the picture image in the project 
may be changed incorrectly. 

 In Multi-Button, there are the following problems. 

- When other than "Bit Write" is selected as the first function in "Function List", even if 
"No Touch Sound" on "Options" tab is enabled, the setting is changed to disabled after 
reopening the project. 

- When "Print" is selected as the first function in "Function List", even if "Alternate" is 
selected as "Action Mode" on "General" tab, the setting is changed to "Momentary" 
after reopening the project. 

- When "Script" is selected as the first function in "Function List", even if 
"Basic/Advanced" mode is "Advanced", the setting is changed to "Basic" after 
reopening the project. 

 In Alarm List Display, when "Screen No." on "Option" tab is greater than or equal to 256, 
incorrect Screen No. is set. 

 When picture is imported in Picture Manager, color of the picture may be converted to an 
unexpected color. 

 



 

 

<Runtime System Software> 

The following functions have been introduced. 

 The judgment of device range error is improved.  This is applicable to HG2G-5T. 

 

<Application Software> 

Bugs Fixed 

The following problems have been fixed: 

 In Preview function, if Buttons, Lamps, or Data Displays are displayed, unnecessary dotted 
rectangle may be displayed. 
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<Runtime System Software> 

The following functions have been introduced. 

 HG1G is supported. 

 "Horizontal (Flip)" of "Installation direction" is supported. This is applicable to HG2G-5T 
and HG1G. 

 FTP Server function is supported. 

Bugs Fixed 

The following problems have been fixed: 

 If "Number of Stored Data for Data Log per Device Address" is odd number, MICRO/I might 
be reset when the Operation Log function works. 

 When the screen which uses "Overlay with Base Screen" is displayed, the values of 
"Coordinates" of "Overlay with Base Screen" are added to the coordinates of the objects on 
the popup screen. 

 If you enter the numbers, the numbers might be drawn out of the frame when "Update the 
display by ENT button" of the Numeric Input is disabled. 

 The scaled image file is different from the HG2G-5S/-S. 

 The transparent areas of Multi-State Lamp and Picture Display are painted with the screen 
background color. 

 

<Application Software> 

The following functions have been introduced. 

 Windows 10 is supported. 

 The properties for new feature of the Runtime System Software are added. 

 Standard popup screens for HG2G-5T are updated to make them usable when vertical 
installation. 

Bugs Fixed 

The following problems have been fixed: 

 In the property of Calendar, even if "Jan/Feb/Mar/…" is selected as "Month" in "General" 
tab, "7-Segment" can be selected as "Font" in "Format" tab. 

 In Preview function, ON/OFF state of Buttons and Lamp is not displayed according to the 
display image of Editing Window. 

 When a project is opened, "Slave1" is selected as "Slave Station" of O/I Link Slave. 

 In Script Editor, when the following functions are described and an assignment expression 
is used for an external device address, it causes script error. 

- ASCII2DEC 

- STRLEN 
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- STRSTR 

 In "User Communication" tab of "Project Settings" dialog box, when "Trigger Condition" 
contains a fixed value, the project may not be able to be downloaded. 

 In "User Communication" tab of "Project Settings" dialog box, even if an invalid device 
address is used in "Trigger Condition", the project can be downloaded. 

 When Reuse Screens is used for the different Type Number of the current project, the 
following problems happen. 

- The part object which uses "Standard" Image Type becomes transparent 

- The property dialog box of the part object which uses "Standard" Image Type cannot 
be opened 

- A new Part object cannot be placed 

 When Print Command or Multi-Command is placed on base screen or popup screen and the 
project is opened and saved without opening those screens, the Print Command and 
Multi-Command may be moved to the left top side(coordinate X:0, Y:0). 

 When Product Series is changed on "Change Product Series" dialog box, the following 
settings in "Project Settings" dialog box are changed to the default. 

- "System" tab - "Use System Area 3,4" 

- "System" tab - "Enable Maintenance" 

- "Communication Interface" tab - "Interface Settings" - "Port No." 

 In "Recipe Settings" dialog box, when "External Memory Device" is selected as "Access to" 
in "Block" tab and "Hexadecimal" is selected as "Display Type" in "Channel" tab, CSV file is 
not created properly by the following operation. 

- Save the recipe files to the External Memory by using "Save Recipe Files to External 
Memory Device..." button in "Recipe Settings" dialog box 

- Download the project to the MICRO/I 

 



 

 

<Runtime System Software> 

The following functions have been introduced. 

 HG4G/3G and HG2G-5F are supported. 

 O/I link communication protocol of HG4F/3F/2F/2S/1F is supported. 

 In the Web Server function, when you do not click anywhere in the remote control page or 
the remote monitoring page in a certain period of time, the current page is automatically 
switched to the home page if you enable this function. 

 In Security function, the password entry screen is displayed automatically when operating 
the parts. 

 In Security function, the setting to notification when an unauthorized user has operated is 
added. 

 In PLC program transfer function, SmartAXIS Pro/Lite is supported. 

 Allen-Bradley Logix Native Tag (Ethernet) driver is supported. 

 The usable device address number ranges of the following IDEC drivers are extended. 

- OpenNet,MICROSmart,SmartAXIS Pro/Lite(RS232C/485) 

- OpenNet,MICROSmart,SmartAXIS Pro/Lite(Ethernet) 

 The message which is displayed when a device range error occurs is modified. 

 The error information string is added in the message which is displayed when a device 
range error occurs. 

XXXXX_Yyyyyyyyy_ZZZZZZZZZ 

X: MICRO/I system software version, Y: Category, y: Details, Z: Reserved 

 

Category and Details are followings. 

B, S Base/Popup screen number (y is the screen and the internal object number of the error's occur) 

G Global Script(y is script ID) 

X User Communication (y is "0000") 

P Preventive Maintenance Function (y is "0000") 

L Data Log or Line Chart (y is "0000") 

R Alarm Log or Recipe (y is "0000") 

O Operation Log (y is "0000") 

Y System Area (y is "0000") 
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Example:43500_B0001_005_01076840E(MICRO/I Version 4.35.00, the base screen number is 
1 and the internal object number is 5) 

 

 When "Show script error" in the Project Setting is checked, MICRO/I displays Device range 
error. 

 After downloading or uploading the project data by using USB Autorun function or the Key 
Button, the SD card and USB memory stick are unmounted. You can pull out the SD card or 
USB memory stick when confirmation screen is displayed. They are mounted again 
automatically when MICRO/I restarts. 

 

<Application Software> 

The following functions have been introduced. 

 The properties for new feature of the Runtime System Software are added. 

 If the project contains a lot of part objects and "Satisfy the condition" or "While satisfying 
the condition" is selected as "Trigger Condition" of those part objects, the performance for 
opening the project is improved. 

 The Behavior of "▶" button which displays the check boxes on "Screen Monitor", "Custom 

Monitor", and "Batch Monitor" dialog box is improved. 

 Check state of radio button is now kept if checked radio button is selected and the Tab key 
is pressed. 

 The following lists are updated faster when changing the number of columns. 

- Alarm Log Settings 

- Recipe Settings 

- "Number of State" of Multi-state Lamp 

- "Number of Registering Constants" of "Data Settings" in User Communication Setting 

- "Number of Items" of Preventive Maintenance 

 When an item is clicked in "Info Window", the related part object is selected. 

 In "Preventive Maintenance Settings" dialog box, if numerical value is entered into 
"Number of Items" directly, the list of "Settings" is now updated immediately. 

Bugs Fixed 

The following problems have been fixed: 

 When "Object List" is displayed, if "Undo" or "Redo" is executed for more than one drawing 
object and part object, WindO/I-NV4 stop operation for a few seconds. 

 Title bar of "Object List" blinks when "Up" or "Down" button on "Object List" is clicked. 

 When both drawing objects and part objects are placed on the same screen, if "Object List" 
is separated from Workspace and its window size is changed, the scroll bar of the "Object 
List" is not displayed properly. In addition, the line which separate drawing objects and part 
objects is not displayed proper position. 

 In "Global Script" dialog box, "..." button displayed in "Trigger Condition" tab is always 
enabled. 

 Other than text can be pasted into "Script" in "Script Editor". 

 In Script, when "if" statement exists in "default" of "switch" statement, the script does not 



 

 

work properly. 

 In Script, when more than two "return" statements exist, the second or later "return" 
statements don't work. 

 In "Script Editor" dialog box, Script Error is not displayed even if "@" is described as device 
address. 

 In Script, the device address of Emerson ROC Protocol can be set as argument of the 
following functions. 

- STRCUT() 

- STRLEN() 

- STRCAT() 

- STRSTR() 

- DEC2ASCII() 

- ASCII2DEC() 

 When the part object which contains script setting is grouped, it is not displayed in "Info 
Window". 

 If Tag Editor is launched from "..." button in property dialog box, and Refresh button is 
pressed, the cells which contain tag name cannot be modified in the Tag Editor in 
Workspace. 

 If Tag Editor is launched from "..." button in property dialog box, and Refresh button is 
pressed, the tag name cannot be changed after entering comment. 

 In Tag Editor, if Delete Key is pressed when tag name and comment are selected, only 
comment is deleted and tag name will not be able to be deleted after the operation. 

 If Emerson ROC Protocol is selected as Communication Driver, the color of the following 
controls is incorrect when they are selected. 

- Location 

- Bit 

 If "Allen-Bradley" format is selected as "Expression of Device Address Format", the device 
address which is configured in Trigger Condition is not restored properly after reopening 
the project. 

 Comments of LSM(HMI Special Relay) and LSD(HMI Special Register) which are imported 
when creating a new project cannot be deleted. 

 Right after clicking "OK" button on "Data Storage Area Management" dialog box, keyboard 
shortcuts for part objects on screen don't work. 

 In "Data Log Settings" dialog box, even if "Up" or "Down" button is pressed, the column of 
"Number of Data" in the list of "Settings" is not displayed properly. 

 If Symbol Factory is opened from "Picture Manager" and clipboard is updated from other 
program, Symbol Factory is closed. 

 Size of NMF file on "Picture Manager" is not displayed. 

 After pictures are imported in "Picture Manager", the folder which contains the imported 
pictures cannot be deleted. 

 When drawing objects are registered to "Picture Manager", the background color may be 
black. 

 If a picture is assigned to a Picture Display and "Undo" is executed, the picture cannot be 
deleted from "Picture Manager". 

 If the picture in "Picture Manager" is used in Picture of drawing object or Part objects, the 



 

 

display image of the picture in Editing Window is smaller than the actual size. 

 In "Communication Driver Network" tab on "Project Settings" dialog box, the setting of 
"External Device Communication" is not reflected if the setting of "External Device 
Communication" is changed and then the tab is changed. 

 In "Communication Driver Network" tab on "Project Settings" dialog box, the same "Slave 
Number" can be selected for more than one External Device ID which is configured the 
same "External Device Communication". 

 In "Communication Driver Network" tab in "Project Settings" dialog box, even if "Disabled" 
is selected as "External Device Communication", "External Device Name" is checked as 
valid name, and error message is displayed. 

 In "Communication Driver" tab in "Project Settings" dialog box, the invalid error message 
"Device Address is empty" is displayed when "Ignore communication errors and continue 
operation" check box is ON and "Not use" is selected as "Manufacture", then "OK" button is 
pressed to close the dialog box. 

 In the following Communication Drivers, "MCIRO/I Port No." of "Expansion Settings" on 
"Communication Driver Network" tab in "Project Settings" is not reflected to the behavior 
of the MICRO/I. 

- YASKAWA Electric MP2000(Ethernet) 

- OMRON SYSMAC CS1/CJ series(Ethernet) 

 When creating a new project if the following Communication Driver is selected, the default 
value of "Expansion Settings" on "Communication Driver Network" tab in "Project Settings" 
is not set. 

- Modbus TCP Client 

- OMRON SYSMAC CS1/CJ series(Ethernet) 

- YASKAWA Electric MP2000(Ethernet) 

- Emerson ROC Protocol 

 When the following conditions are satisfied, the project cannot be reopened if "Project 
Settings" dialog box is closed by "OK" button. 

- Emerson ROC Protocol is selected as Communication Driver 

- TLP device address format is used 

 The device address of "Change IP Address and Port Number by Device Address" on 
"Communication Interface" tab in "Project Settings" is not replaced by Replace function. 

 After reopening the project, "Baud Rate" is displayed as blank when "O/I Link Master" or 
"O/I Link Slave" is selected as "Function" on "Communication Interface" tab in "Project 
Settings" dialog box. 

 In "Individual Settings" dialog box of "Preventive Maintenance", when "Measure Operation 
Count" check box in "Operation Count" is OFF, "..." button of "Monitor Device Address" is 
masked. 

 In "Preventive Maintenance Settings" dialog box, even if "Up" or "Down" button is pressed, 
the following columns in the list of "Settings" are not displayed properly. 

- "Operation Count" - "Level2 Threshold" and "Level2 Report Device Address" 

- "Operation Count" - "Level3 Threshold" and "Level3 Report Device Address" 

 In "External Memory Device" tab of "Alarm Log Settings" dialog box, error message is 
displayed even if correct device address is set to "Specify File Name by Value of Device 
Address". 

 Invalid device addresses are displayed on "Source" column of "Settings" when the device 



 

 

address of Emerson ROC Protocol is assigned on "Channel" tab in "Alarm Log Settings" 
dialog box. 

 Scroll bar of Screen Monitor may be moved to cursor position forcibly. 

 If a project file is dragged and dropped during monitoring, the current opening project is 
forcibly closed. 

 Device addresses may not be replaced when replace function is executed while monitoring. 

 "External Devices" icon in "Online" tab is active even if "External Device Communication 1 
to 4" is not configured in the current project. 

 If the project name consists of 50 byte characters, Monitor, Download and Upload cannot 
be used. In addition, the project name is displayed as blank in "Target Information" dialog 
box. 

 When the following conditions are satisfied, the files which are stored in External Memory 
of the MICRO/I cannot be uploaded. 

- After launching WindO/I-NV4, Online functions such as Download and etc. have not 
been used 

- Project is not opened 

 When uploading the project from MICRO/I, if a picture file is exist in External Memory and 
the picture file is not registered in the "Picture Manager" of the uploaded project, the 
project cannot be downloaded. 

 Even if a part of Picture or Text of drawing object or Part object is placed on the outside of 
the screen area, error message does not appear when the screen is not opened. 

 In the following functions, if a column in the list in "Open Screens" dialog box is double 
clicked, the selected screen is opened. 

- Reuse Screen 

- Replace 

 In the following dialog box, a part of the cells disappear when the mouse cursor is moved 
on the cells. 

- "Screen Properties" 

- "Properties of Multi-Button" 

- "Properties of Multi-Command" 

 Symbols of multi byte character can be set in the following settings. 

- "Security" - "User Name" 

- "Security" - "Use Password to open Project" 

- "Properties of Key Button" - "Location" 

 Mouse cursor image is not displayed properly after clicking "?" icon which is located at the 
left top side of dialog box. 

 Screen Diagram is not updated correctly when screens are deleted or "Number" of screens 
is modified. 

 Invalid device address can be set by using "Replace" function. 

 If the following alignment is configured, and "Stroke" is selected as "Font", the text is not 
displayed proper position. 

- Align Text Horizontal: Center-Left, Left-Right 

- Align Text Vertical: Center-Top 

 In Text of drawing object, if the following conditions are satisfied, the text is not displayed 
proper position when "Text Group" on Status bar is changed. 



 

 

- "Use Text Area" check box is OFF 

- "Use Text Manager" check box is ON 

 If the WindO/I-NV2 project contains the Multi-Command which has the following Word 
Write Command, the property dialog box is displayed as "Basic" mode instead of 
"Advanced" mode when the project is opened by WindO/I-NV4. 

- "Action Mode" : "Move" 

- "Data Type" : "BIN32(+)" 

 If a text ID of "Text Manager" is assigned to registration text of Buttons and "Bold" is 
selected as "Style", the selected item of "Style" is changed to "Regular" from "Bold" after 
reopening the project. 

(This defect only happens in Japanese and Chinese Edition.) 

 In Bit Button, if "Reset" or "Toggle" is selected as "Action Mode" and this Bit Button is 
converted to Word button by using "Change Part Type" in Context Menu, the property 
dialog box cannot be opened. 

 In Key Button, warning message is not displayed when a key is selected in "Key Browser" 
even if Registration Text is already entered. 

 In the property dialog box of Numerical Input and Character Input, unnecessary 
verification is executed and error message is displayed. 

 If a popup screen is created from the property dialog box of Numerical Input or Character 
Input, and then the following part object is placed on it, the popup screen is not displayed 
properly. 

- Selector Switch 

- Potentiometer 

- Keypad 

- Alarm List Display 

- Alarm Log Display 

 In Numerical Input, if the following items are selected as "Methods of using the Numerical 
Input", a different item is selected when reopening the project. 

- Display the Minimum value specified with Data Over 

- Display the Maximum value specified with Data Over 

 When the following part object is placed and the object size is indicated, the flange area 
and button area may be overlapped. 

- Selector Switch 

- Potentiometer 

 In Calendar, if the following conditions are satisfied, error message appears when 
downloading the project. 

- "Alarm" or "Clock & Alarm" is selected as "Calendar Type" 

- "Device Address" is selected in "Alarm" tab 

 If Windows font is selected as Registration Text of Multi-state Lamp, the screen which 
contains the Multi-state Lamp cannot be opened after reopening the project. 

 In the property dialog box of Multi-state Lamp, if numerical value is entered into "Number 
of State" in "State" tab, and it decrease the number of state, incorrect number of columns 
are displayed in the list of "Settings". 

 When "OK" button is pressed in the property dialog box of Multi-state Lamp, the image and 



 

 

registration text of state 0 is displayed. 

 In Message Switching Display and Multi-state Lamp, if the following alignment is 
configured, the coordinate of the text becomes incorrect in Editing Window and the 
MICRO/I. 

- Align Text Horizontal: Center-Left, Left-Right 

- Align Text Vertical: Center-Top 

 In Alarm List Display, the registration text of the buttons are not displayed in proper 
position in "View" tab. 

 In the property dialog box of Alarm List Display and Alarm Log Display, if "Browse" button 
in "View" tab is pressed, and a Fixed Flange object is selected in "View Browser", the width 
of flange in Editing Window is wider than proper width. 

 In Alarm List Display and Alarm Log Display, the setting of "Style" in "Format" tab is 
reflected to the registration text of the buttons in "View" tab and "View Browser". 

 In the property dialog box of Alarm Log Display, even if a text which is registered in "Text 
Manager" is assigned to the "Title" in "Log" tab, the setting of "Style" in "Format" tab is not 
reflected to the title text of Alarm Log Display in Editing Window. 

 In the property dialog box of Alarm Log Display, the height of background of messages in 
Editing Window is different from the display image on MICRO/I when "Reverse" check box 
in "Format" tab is checked. 

 In "Format" tab on the property dialog box of Alarm List Display and Alarm Log Display, if 
other than 1 is selected as "Magnification H", and then the same part object is created on 
the screen, the message area of the new object is not displayed properly. 

 In "Format" tab on the property dialog box of Alarm Log Display, if other than 1 is selected 
as "Magnification H", the following problems occur. 

- In Editing Window, messages on Alarm Log Display are not displayed properly 

- In Editing Window, the coordinate of messages and Lines on Alarm Log Display is not 
the same as the MICRO/I 

 Even if base screens and popup screens are reopened, "Undo" and "Redo" work. 

 If following items are changed from context menu, the result is not displayed correctly, and 
"Undo" does not work. 

- "Line Width" 

- "Line Type" 

- "Color" - "Foreground Color", "Background Color", "Text Color", "Text Background 
Color", "Shadow Color" 

- "Size" - "Make Same Width", "Make Same Height" 

 In Editing Window, when more than one drawing object and part object is moved, the 
rectangles which indicate the objects are not displayed properly. 

 In Line of drawing object, if the coordinate of X or Y is configured from "Format" tab in 
Ribbon and the value is greater than the Editing Window, the configuration is not applied. 

 Drawing objects and part objects which are bigger than the base screen size cannot be 
resized in Editing Window. 

 The context menu which is displayed when drawing objects or part objects are not selected 
appears when the dot line which indicates the popup screen in the base screen is selected 
and left mouse button is clicked. 

 A part of the rectangle is not displayed properly while the Rectangle of drawing object is 
resizing in Editing Window. 



 

 

 If the following drawing objects are located outside of Editing Window, scroll bar is not 
displayed. 

- "Point 1" of Line 

- Fill 

 If Line and other drawing objects are selected and moved to the side of Editing Window, 
the positional relationship between those drawing objects is changed. 

 If more than one drawing object and part object is selected and "Send to Back" is executed, 
the order of the selected objects is reversed. 

 If Reshape mode of Poly Line or Polygon is terminated by "ESC" key, and then "Line" on 
"Home" tab is clicked, unexpected line is drawn from the End Point of PolyLine or Polygon 
to the top left corner of Editing Window. 

 The following items are not displayed properly when the part object is placed outside of the 
base screen or popup screen. 

- Part Name 

- Device Address 

- Trigger Condition 

- Security Group 

 Grid setting is not applied when moving or resizing the dot line of the popup screen. 

 If Reshape mode of Poly Line or Polygon is terminated by "ESC" key, and then Poly Line or 
Polygon is selected in Toolbox and the drawing object is drawn, unexpected line is drawn 
from the top left corner of Editing Window to the Start Point of the drawing object. 

 The Rectangle of drawing object which contains the following settings is not displayed in 
Editing Window. 

- "Curve" is selected as "Round Type" 

- "1" is entered as "Round Radios" 

- "Convex" or "Concave" is selected as "Shadow" 

 "Display" and "Input" check box on "View" tab in Ribbon may become active even if 
screens are not opened. 

 If Line of drawing object and other drawing object or Part object is selected and "Align" is 
executed, the function may not work properly. 

 In Editing Window, even if "Snap to Grid" is enabled, a drawing object may not be snapped 
to the grid when it is resized. 

 If the WindO/I-NV2 project name is changed without WindO/I-NV2, and then the project is 
opened by WindO/I-NV4, the settings on "Communication Driver Network" tab in "Project 
Settings" dialog box is deleted. 

 The picture which satisfies the following conditions is not displayed as X sign after 
downloading the project to the MICRO/I if the project is originally created by WindO/I-NV2 
and opened by WindO/I-NV4. 

- NMF picture 

- The picture is stored into External Memory 

 If the WindO/I-NV2 project contains Text of drawing object and "Use Text Area" is OFF, the 
size of Text is increased by 1 dot after the project is opened by WindO/I-NV4. 

 If the WindO/I-NV2 project contains Multi-state Lamp and it satisfies the following 
conditions, linefeeds are removed when the project is opened by WindO/I-NV4. 

- "Windows" is selected as "Font" in "Registration Text" tab 



 

 

- Registration Text contains linefeeds 

 If "Active User" is registered in Quick Access Tool Bar and "OK" button is pressed in "Open 
Screens" dialog box when opening a project, the following message appears. 

"WindO/I-NV4 cannot read this file. 

This is not a valid file, or its format is not a project file." 

 When "Arrange" or "Size" is added to Quick Access Tool Bar and "Coordinates" or "Size" of 
Drawing objects or Part objects is changed by those "Arrange" or "Size", the display image 
on Editing Window is not changed. 

 When "Arrange" is added to Quick Access Tool Bar and set the focus to "X" or "Y" of the 
"Arrange", "Align" and "Rotate" cannot be used from the "Arrange". 

 If the text box of "State" in "View" tab is added to Quick Access Tool Bar, and then 
Multi-state Lamp, Message Switching Display or Picture Display is placed on Editing 
Window, WindO/I-NV4 crash. 

 If the text box for changing screen in "Online" tab is added to Quick Access Tool Bar, and 
enter invalid character while monitoring, WindO/I-NV4 crash. 

 Label text in Ribbon can be added to Quick Access Tool Bar. 

 The icon which is registered on Quick Access Tool Bar is not masked when project is not 
opened. 

 Even if Text Group is changed, "Text Group" in Quick Access Tool Bar is not updated. 

 When "Emerson RCO Protocol" is selected as Communication driver and a device address 
of TLP device format is selected as "Source" on "General" tab in "Individual Settings" dialog 
box of "Data Log Settings" dialog box, the project cannot be opened. 

 When reopening the project, "O/I Link Station" on "O/I Link" tab in "Project Settings" is 
change back to the default. 

 



 

 

<Runtime System Software> 

Bugs Fixed 

The following problems have been fixed: 

 If more than one communication driver is configured, MICRO/I might be reset when an 
indirect read is executed to a non-existent device address in the external device. 

 In Line Chart, when the date and time data at the position indicated by the cursor is 
displayed with 7-Segment font, it is not displayed correctly. 

 

<Application Software> 

The following functions have been introduced. 

 Color Palette or Pattern Palette is displayed when other area than the down triangle symbol 
on color selection button or pattern selection button is clicked. 

 When [Picture Manager] or [Script Manager] is opened from property dialog box, the 
selected item in the property dialog box is selected as default. 

 After a picture is imported in [Picture Manager], the format of the picture file is properly 
converted according to the original format and the state of [Color Exchange] check box. 

Bugs Fixed 

The following problems have been fixed: 

 The following problems happen when decimal symbol in [Region and Language] is not 
period. ([Region and Language] is configuration of Windows OS) 

- Fixed value cannot be set in [Trigger Condition] when [Data Type] is "Float32(F)". 

- Property dialog box of Part object cannot be opened when [Data Type] is "Float32(F)" 
(This problem only happens when setting of [Value] exists). 

 

In addition to above, the following problems happen when digit grouping symbol is 
"space". 

- Project cannot be downloaded. 

- WindO/I-NV2 project cannot be opened. 

 If Windows font is used, the image is lacked. 

 For Line Chart, if Windows font is used for label which is displayed on Y-Axis, the label is 
displayed on incorrect position in Editing Window. 

 When opening project, setting of [Back to Default User] in [Security] dialog box is not 
restored correctly. 

 In [Project Settings] dialog box, if "User Communication" or "Sub Host Communication" is 
selected as [Function] of "SERIAL1(RS422/485)" in [Communication Interface] tab, "Serial 
Interface" may be changed to "RS422/485 2-wire". 
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 Change Product Series does not work when project name contains period. 

 While changing product series, if [Cancel] button is clicked on [Save As] dialog box, 
changing product series is canceled, but [Installation] is changed. 

 Project may not be uploaded if picture exists in [Picture Manager] of the project. 

 If base screens or popup screens are reused with [Reuse Screen] from project whose 
[Installation] is different, size of reused screens becomes invalid. 

 For Line Chart, if [Chart Type] is "Device Address Display" and [Reference Device Address] 
is device address of External Device, the Line Chart does not work on MICRO/I correctly. 

 If WindO/I-NV2 project contains Message Display and its [Change Color by Device] is 
enabled, this Message Display does not work after the project is opened and then 
downloaded with WindO/I-NV4. 

 If picture files are imported in WindO/I-NV2 project with [Import with color conversion] 
enabled, these picture files may be displayed incorrectly after the project is opened with 
WindO/I-NV4. 

 Image of imported picture file in [Picture Manager] may becomes incorrect when format of 
the picture file is following. 

- ICO file 

- WMF file 

 When WMF file is imported in [Picture Manager], the size of the imported picture file is not 
proper. 

 Even if duplicated [Text ID] is found when [Copy], [Cut], [Paste], or [Reuse Screen] is used, 
confirmation message for overwriting [Text ID] is not displayed. 

 Even if [Text Align] in [Format] tab is changed in property dialog box, the modification may 
not be reflected when multiple Numerical Inputs or Numerical Displays are selected. 

 Even if [With Unit] in [Format] tab is changed in property dialog box, the modification may 
not be reflected in Editing Window when multiple Numerical Inputs or Numerical Displays 
are selected. 

 For Numerical Input and Numerical Display, if numerical value is set as unit, its preview is 
not correctly displayed in Editing Window. 

 WindO/I-NV2 project cannot be opened when NMF image which contains Circle/Ellipse or 
Arc is imported in [Picture Manager].  

 For Numerical Input, Character Input, Message Display, Message Switching Display, 
Numerical Display, and Calendar, property dialog box cannot be closed with [OK] button if 
all following conditions are satisfied. 

- [Image Type] is "None". 

- The last item in [Object List] is a button. 

 If O/I Link Slave is configured in [Project Settings] dialog box, error message is displayed 
and the dialog box cannot be closed. 

 If Multi-Button is arranged, following problems may happen. 

- If "Bit Write" is set as second or later item in [Function List], and [Destination Device 
Address] is a device address of External Device, the Bit Write does not work correctly. 

- If "Word Write" is set as second or later item in [Function List], [Transfer] and [Write] 
become default after reopening project. 

 If [Reuse Screen] is used, the following problems may happen. 

- Device addresses and [Trigger Condition] in the duplicated screens are deleted. 



 

 

- "NG" is displayed on [Error] column in [Script Manager] 

 If [Not Display Image] is enabled in Pilot Lamp, following problems happen. 

- If the screen which contains this Pilot Lamp is reused with [Reuse Screen], the screens 
may not be displayed correctly. 

- This Pilot Lamp cannot be pasted to another WindO/I-NV4 screen. 

 When multiple screens are reused with [Reuse Screen], following problems happen if the 
same picture is used in more than one screen. 

- the reused screens may not be displayed 

- the picture in the reused screens is not correct 

 When multiple screens are reused with [Reuse Screen], setting of Script Manager may 
become incorrect if the same script ID is used in more than one screen. 

 Security setting may becomes incorrect if downloading or uploading is aborted. 

 Project may not be saved correctly if Bit Number of LKR (HMI Keep Register) is used. 

 For Message Switching Display and Keypad, if all following conditions are satisfied, the 
screen which contains the part object is deleted. 

- "Stroke" is selected as [Font] 

- Message is set in [Message] tab (For Message Switching Display only) 

 



 

 

<Runtime System Software> 

Bugs Fixed 

The following problems have been fixed: 

 When the screen display is updated, MICRO/I might be reset. 
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<Runtime System Software> 

Bugs Fixed 

The following problems have been fixed: 

 When Modbus TCP Server driver is set to other than "External Device Communication 1", 
MICRO/I can not communicate to the external devices. 

 

<Application Software> 

The following functions have been introduced. 

 Auto Backup function is supported. 

 In [Project Settings] dialog box, if [External Device Communication] is used in 
[Communication Interface] tab or [Communication Driver Network] tab, and 
Communication Driver is not assigned to the [External Device Communication], Error 
Message appears. 

Bugs Fixed 

The following problems have been fixed: 

 After reopening the project, when "Recipe Setting" dialog box is not opened and project is 
downloaded, MICRO/I reads and writes to incorrect recipe files. 

 Project may not be saved. 

 When property dialog box of Line Chart is closed, the following message may appear even 
if there is no invalid setting. 

"The sampling method of the "Channel Number" has different settings. 

It may not be displayed correctly. Do you want to continue?" 

 When reuse screens, the following problems which are related to HMI Keep Relay(LK) and 
HMI Keep Register(LKR) happen. 

- The property which uses those device addresses is changed to blank. 

- If those device addresses are used in script, the device addresses are not deleted even 
if the address is grater than the maximum address. 

 When changing communication driver, the property which uses the following device 
address is changed to blank. 

- The device address can be read and written by MICRO/I in the communication driver 
which is configured before changing 

- The device address can be read, but cannot be written by MICRO/I in the 
communication driver which is configured after changing 

 When changing communication driver, a part of scripts is removed. 

 If the security group which is assigned to a part object does not exist and "Undo" or "Redo" 
is executed, security setting becomes invalid and the following problem may happen. 
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- The property dialog box of part object can not be closed 

- WindO/I-NV4 may freeze if you edit Security Group setting 

 If you operate the following steps, the event names are not described in Operation log file 
in External Memory. 

1. Create a new project 

2. Disable Operation Log function and save the project 

3. Reopen the project and enable Operation Log function 

4. Download the project to the MICRO/I 

 The downloaded recipe file name in External Memory is not proper. The default file name is 
used instead of the setting file name on "Block" tab in "Recipe Setting" dialog box. 

 In Protocol 2 through 7, if "User Communication" is selected as "Function", the same device 
address of Protocol 1 is displayed in "Change IP Address and Port Number by Device 
Address". 

 If "Windows" is selected as "Font" for Text ID1 of Text Group1 in Text Manager, and "Bold 
Italic" is selected as "Style" of the Windows font, the "Style" setting is changed to "Regular" 
after reopening Text Manager. 

 In Message Switching Display, "Text Color" and "Plate Color" on "Message" tab are not 
reflected to the display image on Editing Window. 

(This defect only happens in Japanese and Chinese Edition.) 

 Project can not be saved when the following conditions are satisfied. 

- The opened screen contains grouped objects or drawings 

- The state of "Handle Logical operations as Bit operations" on "Compatible" tab in 
"Project Settings" dialog box is changed. 

 In Message Switching Display, If "Value" is selected as "Switching Method" in "General" tab, 
the following defects are caused. 

- If the value of "State" on "Screen" group in "View" tab of Ribbon is grater than 15 and 
"Switching Method" is changed to "Bit Number", the property dialog box of the Message 
Switching Display can not be closed. 

- Even if the order of the message is changed in "Message" tab, it is not reflected to the 
display image of the Message Switching Display on Editing Window. 

 when the value of "State" on "Screen" group in "View" tab of Ribbon is not zero, the 
following objects can not be displayed as proper state. 

- Duplicated Message Switching Display, Multistate Lamp and Picture Display 

- Pasted Message Switching Display 

 If you copy a object and paste it to another WindO/I-NV4, the device address of HMI Keep 
Relay(LK) and HMI Keep Register(LKR) which is grater than the settings in "Data Storage 
Area Management" dialog box can be assigned.  

 The latest modification is not restored from backup project which can be opened from 
"Project Recovery" dialog box. 

 Script Error may happen if "Handle Logical operations as Bit operations" on "Compatible" 
tab in "Project Settings" dialog box is enabled. 

 Even if "Handle Logical operations as Bit operations" on "Compatible" tab in "Project 
Settings" dialog box is changed, the setting is not reflected to "Trigger Condition". 

 The selected Text color in [Format] tab is displayed as the Text color of Message Switching 
Display instead of the Text color of "Msg0" when reopen the project. 



 

 

 In Message Switching Display, if [Use Text Manager] is enabled and the parameter of 
[Change] column is changed from "Y" to "blank", the entered message is deleted. 

 If "Windows" is selected as [Font] in property of Text, the following problems happen. 

- If "Bold" is selected as [Style], it is changed to "Regular" after reopening the project. 

- If "Bold Italic" is selected as [Style], it is changed to "Bold" after reopening the project. 

 If two WindO/I-NV4 are launched and different communication drivers are assigned, and 
then Multi Button, Multi Command or Script Command is copied and pasted each other, 
device addresses in the script which is assigned to the object may be deleted. 

 If entered tag name or comment in Tag Editor contains vertical bar( | ), it is deleted. 

 In script or Trigger Condition, if used device address is Hexadecimal, MICRO/I access to 
incorrect device address. 

 If Tag Editor is launched by clicking […] button, and the entered device address is 
Hexadecimal, incorrect device address is selected in Tag Editor. 

 Confirmation message for saving project is not displayed even if the project is changed by 
the following operation. 

- Use [Auto Resize] 

- Use [Up][Down] button in [Object List] 

- Change the value of [X]/[Y] on [Arrange] group in [Format] tab 

- Use [Delete] or [Reduce] button in [Script Manager] 

- Use [Reuse Screen] 

- Change the name of base screen or popup screen on [Project] tab in [Workspace] 

- Press [OK] button in [Screen Properties] dialog box when the screen is not 
opened.([Screen Properties] dialog box can be opened from [Project] tab in 
[Workspace]) 

- Paste base screen or popup screen on [Project] tab in [Workspace] 

- Add a new list in [Registration Monitor] 

 If [Save Auto Recover information every] is enabled, the following problems happen. 

- The modification of the project is not reflected after downloading the project. 

- Confirmation message for saving project is not displayed even if the project is modified. 

 If Emerson ROC Protocol is selected and TLP type format is used as device address, 
MICRO/I accesses to incorrect device address. 

 If "@" is used in tag name and the tag name is used in script, unexpected error message is 
displayed. 

 If an existing project is opened, [Auto Resize] function does not work even if the [Auto 
Resize] button is enabled. 

 Even if the property of Popup screen is changed, it may not be reflected to the dotted 
rectangle which is displayed when [Popup Screen] on [Show/Hide] group in [View] tab is 
enabled. 

 The folder path which contains a dot character can not be specified as [Default file 
Location] on [Save] tab in [WindO/I-NV4 Options] dialog box 

 Even if the device address is not exist in the project, it can be set in part object after 
Undo/Redo is executed. 

 



 

 

<Runtime System Software> 

Bugs Fixed 

The following problems have been fixed: 

 When showing the system information of "HG2G-5TT22TF-*" using the WindO/I-NV4, 
"HG2G-5TT22TF-*" is displayed on "Type Number" in the Target Information dialog box. 

 When SIEMENS S7-1200(Ethernet) driver is selected, incorrect value may be written to 
external device addresses if value is written in more than one external device addresses at 
the same time. 

 When SIEMENS S7-1200(Ethernet) driver is selected, value may be written to incorrect 
external device addresses if the value is written in more than one external device 
addresses at the same time by using script function. This happens if the external device 
addresses are not sequential number. 

 

<Application Software> 

Bugs Fixed 

The following problems have been fixed: 

 When Object List was floating, Drawing objects and Part objects were not selected even if 
the listed objects in the Object List were selected. 

 The listed items in Tag Editor on Workspace are not the same as Tag Editor which is called 
from […] button when "Used Address Numbers" is selected as "Show" in Tag Editor. 

 Incorrect information is displayed in Tag Editor on Workspace if "Used Address Numbers" is 
selected as "Show" in Tag Editor which is called from […] button.  

 When you reopen and edit your project if you paste or duplicate parts, the address number 
is added "1" regardless of the setting of "Increment Address". 

 The following 1 is not displayed proper position on MICRO/I if the project is downloaded 
without opening the screen which contains 1 and 2. 

1. Text Object in which "Center-Left" is selected as "Align Text Horizontal" 

2. Any Buttons 

 Error message is displayed if any device addresses are not used in the formula for "Input 
with Arithmetic Operation" or "Display with Arithmetic Operation" on "Options" tab in 
"Numerical Input" or "Numerical Display" dialog box. 

 The state of the following check boxes on "Download" dialog box changes whenever you 
download a project. 

- Download Recipe Files to External Memory Device 

- Download Picture Files to External Memory Device 

 The maximum value of Height and Width in the property of Drawing objects and Part 
object is incorrect if "Vertical (Counter Clockwise)" or "Vertical (Clockwise)" selected as 
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[Installation] 

 If "32-bit" is selected as "Data Type" in "Data Log Settings", the maximum value of 
"Number of Stored Data for Data Log per Device Address" in "Data Storage Area 
Management" dialog box is incorrect. 

 If Emerson ROC Protocol is selected as Communication driver, the Parameters which has 
unsupported data type of TIME are shown on Tag Editor dialog. 

 If the following conditions are satisfied, the project can not be opened properly. 

- "Windows" is selected as "Font" in Multi-State Lamp 

- The project is created by WindO/I-NV2(*.n2g) 

 



 

 

<Runtime System Software> 

The following functions have been introduced. 

 The HG2G-5T is now supported. 

 

<Application Software> 

The following functions have been introduced. 

 Add functions and settings with supporting the runtime system software for HG2G-5T. 
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